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CE LOGICIEL N’EST PLUS DISPONIBLE À L’INSPQ DEPUIS JUIN 2016 

Créer de nouvelles bases bibliographiques dans Reference Manager 

Créer deux nouvelles bases, une pour les références dédoublonnées et l’autre pour les doublons : File → New Database… → choisir 
un emplacement et attribuer un nom significatif (sans espace ni signe diacritique) → ex. : ecigarette et ecig-doublons 

OU ouvrir des bases déjà créées : File → Open Database… → choisir les bases désirées 

Paramétrer le résolveur de liens  : Tools → Options → Internet Search → cocher la case Enable 

OpenURL → à Open URL Path, inscrire http://ju8hq7vq3l.search.serialssolutions.com → laisser le champ Arguments tel quel → 
Appliquer → clic droit sur la référence désirée → OpenURL 

 Autres résolveurs : Université Laval, Université de Montréal, Université McGill (à valider), autres universités, WorldCat 

Affiliation → s’assurer que son navigateur soit configuré pour le proxy/VPN de son université (requête à la DATI s’il y a lieu) 

Les bases créées avec RefMan 12 (d’Estimauville) sont incompatibles avec RefMan 11 (Wolfe, Crémazie, LSPQ) 

Peu importe la ressource interrogée, il est toujours préférable de sauvegarder les références dans un fichier RIS que l’on 
importe ensuite dans le logiciel désiré. Ainsi, les informations bibliographiques restent dans les champs adéquats. 

L’extension .rmd désigne la base de données bibliographiques alors que .rmx désigne la structure de la base (ses index) 

Exporter des références bibliographiques dans des fichiers .ris avec les bases sous Ovid 

Comme l’exportation directe est problématique (informations bibliographiques pas exportées dans les bons champs), il est 
préférable d’opter pour l’exportation indirecte nécessitant la création d'un fichier texte 

Ovid ne permet pas de rechercher des termes ou des noms incluant des 
signes diacritiques (accents, cédille, tréma), un tilde ~ ou des ligatures (œ pour oe, æ pour ae, & pour et)  

Par conséquent, de tels caractères ne peuvent être exportés et doivent être rectifiés manuellement 

À la suite de la recherche : 

 Sélectionner les références à exporter → options : a) cocher Tout (si ≤ 200 références), b) préciser la plage désirée (par blocs de 
≤ 200 références) OU c) cocher les cases des références désirées 

 

 Cliquer sur Exporter → à Exporter vers, choisir RIS → à 
Sélectionner les champs à afficher, opter pour Référence 
complète (à Inclure, cocher ou non la case Liens vers le texte 
intégral Ovid dans la référence) → Exporter la ou les citations 

 

 Dans le menu déroulant de Enregistrer, choisir Enregistrer sous (si l’option est disponible) → enregistrer le fichier ris.ris à 
l’emplacement désiré (conseil : le renommer avec un nom significatif : ex. : embase-ovid-61.ris) 

http://creativecommons.org/licenses/by-nc-nd/2.5/ca/
http://ju8hq7vq3l.search.serialssolutions.com/
http://sfx.bibl.ulval.ca:9003/sfx_local
http://opurl.bib.umontreal.ca:9003/sfx_local
http://mclink.library.mcgill.ca/sfx
http://cgit.drupalcode.org/link_resolver/tree/resolvers.csv?id=634890fa375a65d6afff3f63b7c1cf524b84cfe3
http://worldcatlibraries.org/registry/gateway
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Exporter des références bibliographiques dans des fichiers .ris avec les bases sous 
EBSCOhost 

Le dédoublonnage, automatique dans EBSCOhost, se traduit par des résultats aléatoires (résultats pertinents éliminés, nombre 
de résultats fluctuant) → il est donc préférable d'interroger cette plateforme une base à la fois, d'exporter les résultats dans 

Reference Manager et de les y dédoublonner 

À la suite de la recherche, sélectionner les références à exporter → options :  

1. Cliquer sur a) le  des références désirées OU b)  → cliquer sur le dossier (par blocs de 50 références) 

2. Cliquer sur Aller à : Vue des dossiers → Sélectionner/désélectionner tout ou cocher les cases désirées → Exporter → Sauvegarder 
les citations dans un fichier au format suivant : Direct Export au format RIS (par ex. […] Reference Manager, Zotero) → 
Sauvegarder 

3. Enregistrer sous → enregistrer le fichier ris.ris à l’emplacement désiré (conseil : le renommer avec un nom significatif : ex. : cinahl-

ebsco-7.ris) 

OU 

1.  → Envoyer un lien avec un e-mail permettant de télécharger les résultats exportés (jusqu’à [max 25 000]) → 
Format RIS → inscrire l’adresse courriel → Envoyer 

      
2. Cliquer sur le lien reçu par courriel → Enregistrer sous → choisir l’emplacement → Enregistrer le dossier .zip 

3. Ouvrir avec → Explorateur Windows (ou décompresser le dossier comprimé) → enregistrer le fichier ris.ris à l’emplacement désiré 
(conseil : le renommer avec un nom significatif : ex. : cinahl-ebsco-7.ris) 

Exporter des références bibliographiques dans des fichiers .ris avec PubMed 

À la suite de la recherche :  

 

1. Cocher la case des références désirées OU ne rien cocher 

pour exporter toutes les références obtenues 

2. Cliquer sur Send to: → Citation manager → s’il y a lieu, 
sélectionner l’intervalle désiré (si ≤ 200) → Create File 

3. Enregistrer le fichier texte citations.nbib à l’emplacement 
désiré (conseil : le renommer avec un nom significatif : ex. : 
pubmed-17.nbib) 

PubMed élimine les signes diacritiques dès l'étape de 
l'exportation, alors il faut les rectifier manuellement 
(ex. : les auteurs Côté S, François K, Domínguez A, 
Cardeñosa N et Martínez A deviennent Cote S, Francois 
K, Dominguez A, Cardenosa N et Martinez A) 

Exporter des références bibliographiques dans des fichiers .ris avec Google Scholar 

Note : comme l’exportation directe est problématique (ex. : signes diacritiques), il est préférable d’opter pour l’exportation indirecte 

nécessitant la création d'un fichier texte 

À la suite de la recherche, sélectionner les références à exporter → options :  

1. Exportation à la pièce à partir de la page des résultats obtenus : 

 Sélectionner une référence en cliquant sur Importer dans RefMan 

 Enregistrer sous → enregistrer le fichier scholar.ris à l’emplacement désiré (conseil : le renommer avec un nom significatif : ex. : 

google-scholar.ris) 

2. OU exportation à la pièce à partir de sa bibliothèque (cela implique de se créer d’abord un compte Gmail) : 

 Sélectionner des références en cliquant, pour chacune d’elles, sur Enregistrer 

 Cliquer sur Ma bibliothèque (en haut à gauche) 

 Sélectionner une référence en cliquant sur Importer dans RefMan 

 Enregistrer sous → enregistrer le fichier scholar.ris à l’emplacement désiré (conseil : le renommer avec un nom significatif : ex. : 

google-scholar.ris) 

http://creativecommons.org/licenses/by-nc-nd/2.5/ca/
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Exporter des références bibliographiques dans des fichiers .ris avec Santécom 

À la suite de la recherche : 

1. Sélectionner des références parmi les résultats obtenus en cochant les cases correspondantes 

2. Dans le menu déroulant de Ajouter à :, choisir Panier (en haut à droite) 

3. Cliquer sur Panier (en haut au centre) → Exemplaires dans votre panier → confirmer les références à exporter en cochant les 
cases correspondantes → Télécharger 

4. Télécharger le panier → à Choisir un format, opter pour RIS (Zotero, EndNote, autres) → Aller 

5. Enregistrer → Enregistrer sous → enregistrer le fichier à l’emplacement désiré (conseil : le renommer avec un nom significatif : ex. : 
santecom-6.ris) → Enregistrer 

 Exporter des références bibliographiques dans des fichiers .ris avec le métamoteur 
360 Search 

Note : le métamoteur permet de rechercher des termes ou des noms incluant des signes diacritiques (accents, cédille, tréma), un tilde 

~ ou des ligatures (œ pour oe, æ pour ae, & pour et), mais lorsque l’on tente de sauvegarder les résultats exportés, un message 

apparaît :  → caractères à rectifier manuellement 

À la suite de la recherche : 

1. Sélectionnez des références parmi les résultats obtenus en cochant les cases correspondantes 

2. Cliquez sur Exporter/Sauvegarder → Format compatible avec Reference Manager, EndNote, etc. (option déjà cochée par défaut) → 
Exporter → Sauvegarder 

Exporter des références bibliographiques dans des fichiers .ris avec ProQuest 

Note préliminaire : le dédoublonnage, automatique, se traduit par des résultats aléatoires (résultats pertinents éliminés, nombre de 

résultats fluctuant) → conseil : interroger cette plateforme une base à la fois (ou cocher, au bas de la page de la recherche avancée, la 
case Doublons : Inclure les documents dupliqués), d'exporter les résultats dans RefMan et de les y dédoublonner 

À la suite de la recherche : 

1. Sélectionner des références parmi les résultats obtenus en cochant les cases correspondantes 

2. Cliquer sur Exporter/Enregistrer → choisir RIS → Continuer 

 Si le navigateur bloque le processus, faire un clic droit sur le message « Pour protéger votre ordinateur, Internet Explorer a 
bloqué le téléchargement de fichiers de ce site vers votre ordinateur. Cliquez ici pour afficher plus d'options... » (en haut sur 
fond jaune) et choisir Télécharger le fichier... → cliquer sur Ouvrir → Autoriser 

3. Enregistrer sous → enregistrer le fichier ProQuestDocuments.ris à l’emplacement désiré (conseil : le renommer avec un nom 
significatif : ex. : environmental-130.ris) 

Importer des références bibliographiques dans Reference Manager 

Avant l’importation dans Reference Manager, faire ceci pour que les caractères particuliers demeurent corrects (les signes 

diacritiques – accents, cédille et tréma –, le tilde et les ligatures comme œ) : 

 faire un clic droit sur le nom du fichier → Ouvrir avec… → Bloc-notes 

 si le bloc-notes ne s’affiche pas par défaut : Autres programmes → Bloc-notes 

 cliquer sur Fichier → Enregistrer sous… → à Encodage, choisir ANSI (au lieu de UTF-8) → Enregistrer → fermer le fichier 

Dans Reference Manager : File → Import Text File… →  

 
 

1. Database: → choisir la base créée (ex. : ecigarette) 

2. Filter: → ... → choisir RIS.cap → Ouvrir 

 Pour PubMed, choisir PubMed.cap 

3. Text file: → ... → à Regarder dans :, s’assurer d’être au bon 
endroit et à Types de fichiers :, changer Text Files (*.txt) par 
All Files (*.*) → choisir le fichier .ris sauvegardé (ex. : 
medline-ovid-18.ris) → Ouvrir 

 Importer les fichiers dans l’ordre désiré (ex. : MEDLINE 
puis EMBASE pour favoriser les références de la 1re et 

demander des PEB par Loansome Doc s’il y a lieu) 

4. Additional keywords: → préciser la base et la plateforme 
(nom simple sans espace, sans accent...; ex. : medline-ovid; 
pubmed1) 

Cela permet de les cibler ensuite avec  

5. Options... → onglets 

 Import → Duplicate references → cocher Put in 
duplicates database: → choisir la base créée (ex. : ecig-
doublons) → Select 

 Duplicate Search → cocher Title, primary; Authors, 
primary; Date, primary; Start Page; Periodical 

 → Appliquer → OK 

6. Import → Append (s'il y a lieu) → Close 

7. S’il y a lieu, remettre manuellement les signes diacritiques 

http://creativecommons.org/licenses/by-nc-nd/2.5/ca/


 

 Vicky Tessier, Services documentaires de l’INSPQ Reference Manager 2015-01-10 – maj 2016-05-05 

Dédoublonner les références importées 

Dédoublonnage automatique par RefMan : le logiciel dédoublonne les références correspondant à tous les critères choisis, alors 

dès qu’une information diffère ou est absente, plusieurs doublons ne sont pas perçus comme tels 

 Cela ne signifie de limiter le nombre de critères de dédoublonnage : s’il n’y en a pas assez, le logiciel pourrait éliminer des 
références qu’il considérerait incorrectement comme des doublons (ex. : articles ayant le même titre, mais publiés dans deux 
revues ou à deux dates différentes) 

Dédoublonnage manuel :  

 trier les références par titre (clic gauche sur l’en-tête grisé 
de la colonne Title) 

 parmi les doublons, déterminer les références les plus 
complètes et les mieux importées 

 cocher les cases des doublons à transférer dans la 
deuxième base (ex. : ecig-doublons) 

 clic droit → Copy Between Databases… → cocher Marked 
Reference(s) et choisir la base de destination → Copy → 
Yes to All 

 valider les numéros (Ref ID) des références importées dans 
la base des doublons 

 supprimer les doublons de la base initiale : clic droit → 
Delete → Marked Reference(s) → OK → Yes to All 

 

Utiliser les références sauvegardées dans Word 

Dans Word, sous Compléments, les fonctionnalités liées à RefMan sont sur la deuxième ligne :  

Attention! Les logiciels de gestion bibliographique ne réagissent pas bien au suivi des modifications dans Word. Par 

conséquent, nous recommandons ceci :  

1) conserver précieusement un document maître lié à la base bibliographique et dans lequel il ne faut JAMAIS activer le suivi 
des modifications ; 

2) se créer un fichier parallèle ; 

3) y effectuer le travail collaboratif avec le suivi des modifications de Word ou l’insertion de commentaires ; 

4) les modifications terminées, les répercuter une par une dans le document maître sans activer le suivi des modifications (dans Word, 
la fonctionnalité Révision → Comparer s’avère alors utile). 

C’est ce document maître qui doit être lié à la base de données bibliographiques dans RefMan et des mises à jour qui y sont faites. 

Gérer les bases bibliographiques créées 

Quelques bonnes pratiques : 

 s’assurer que tous utilisent la même base bibliographique, ou du moins qu’une personne ait officiellement la responsabilité 
d’importer tout au même endroit 

 lorsqu’un projet est terminé, exporter l’ensemble des références dans un fichier ris clairement identifié et classer ce fichier à un seul 
emplacement (éviter les copies multiples) 

Exporter des références bibliographiques de Reference Manager pour les importer dans un 
autre logiciel 

Procédure à faire pour que les signes diacritiques demeurent corrects : 

 Ouvrir la base bibliographique dans RefMan 

 Tools → Bibliography → Generate from Reference List... (ou Ctrl-L) 

 Onglet General 

 À Output Style, choisir le style RIS export (cliquer sur les trois points pour le choisir s’il y a lieu) 

o Si le chemin d’accès indiqué ne permet pas de l’obtenir, récupérer le fichier à cet endroit : S:\partage\Bases Reference 
Manager\RIS export.os 

 À Optional Fields, cocher toutes les cases 

 À l’onglet Page, décocher la case Number Pages, Beginning With: 

 Cliquer sur OK 

 À Enregistrer sous, à Type :, choisir l'option Text Only 

 Enregistrer le fichier texte à l’emplacement désiré (conseil : le renommer avec un nom significatif : ex. : refman-ecig.txt) 

Le fichier ainsi créé (avec l’extension .txt) est prêt pour l'importation dans un autre outil de gestion bibliographique comme Zotero 

Si, malgré cela, le signes diacritiques s’affichent incorrectement dans Zotero :  

 faire un clic droit sur le nom du fichier créé précédemment (avec l’extension .txt) → Ouvrir avec… → Bloc-notes 

 si le bloc-notes ne s’affiche pas par défaut : Autres programmes → Bloc-notes 

 cliquer sur Fichier → Enregistrer sous… → à Encodage, choisir UTF-8 (au lieu de ANSI) → Enregistrer → fermer le fichier 

 dans Zotero : Fichier → Importer… → sélectionner le fichier .ris à importer → Ouvrir 

À consulter 

 Technical Support & Services de RefMan : tutoriels, Output Styles, foire aux questions, forum de discussion, etc. 

 Reference Manager: Managing Your Search Results des NIH : tutoriels, documentation, guides (versions 10, 11 et 12) 

 Fiche synthèse sur Zotero 

 

http://creativecommons.org/licenses/by-nc-nd/2.5/ca/
file://///inspq.qc.ca/dfs/Secure/INSPQ/partage/Bases%20Reference%20Manager/RIS%20export.os
file://///inspq.qc.ca/dfs/Secure/INSPQ/partage/Bases%20Reference%20Manager/RIS%20export.os
http://www.refman.com/support/rmsupport.asp
http://www.refman.com/training/
http://www.refman.com/support/rmstyles.asp
http://forums.thomsonscientific.com/ts/?category.id=refman
http://nihlibrary.nih.gov/ResourceTraining/pages/TrainingDescription.aspx?rsID=35&View=AllTraining
http://intranet.inspq.qc.ca/RessourcesServices/Documentation/AideRecherche/Lists/Guides%20daide%20%20la%20recherche/Attachments/45/fs-zotero.pdf

